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CHAPTER 1

Welcome
Approximate Time: 40 minutes

Welcome to the Flare Lists Tutorial.

n Tutorial Goal Learning how to create and manage various types of lists.

n Key Concepts Creating simple and multi-level lists, controlling list styles, adding page breaks
within list items, and understanding definition lists.
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CHAPTER 2

Creating a Project From a
Template
To start, let's create a new project based on Flare's Austin template.
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How to Create a New Project From a
Template
1. Select File > New Project. The Start New Project Wizard opens.

2. In the Project name field, give your project any name you want.

3. (Optional) In the Project folder field, you can enter a location where you want to save your
project. By default, projects are saved in your Documents > My Projects folder.

4. Click Next.

5. Under Factory Templates, expand the Tutorials folder. Select the Austin template.

6. Click Next.

7. For branding, keep the default settings. (This is where you could customize your project's
look with branding, such as colors and logo.) Click Next.

8. Click Finish. The project is created and loaded into Flare.
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CHAPTER 3

Creating Bulleted and
Numbered Lists
Let's create some simple and multi-level lists.

This chapter discusses the following:

How to Create a Simple Bulleted List 10

How to Create Multiple Levels in the Bulleted List 15

How to Create a Simple Numbered List 18

How to Create Multiple Levels in the Numbered List 23
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How to Create a Simple Bulleted List
1. From the Content Explorer, double-click the Attractions.htm topic. The topic opens in the XML

Editor.

2. Scroll down to the bottom of the topic, place your cursor to the right of the last image and
press ENTER to create an empty paragraph.
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3. Copy and paste the following text at that location.

Things You Need for Kayaking

Paddle

Get the right size.

Don't choose a paddle made of jello.

Life jacket

Make sure it is snug.

Don't choose a life jacket made of jello either.

Bilge pump (for bailing water)
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4. Place your cursor anywhere in the first paragraph ("Things You Need for Kayaking"), and from
the Home ribbon, click in the Style drop-down and select h3.
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5. Select the rest of the text under the new heading.
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6. From the Home ribbon, click the face of the List button (or you can click the down arrow
and select Bullet List).

You now have a simple bulleted list.

TIP When starting a new list, it is best to select either the Bullet List or Numbered List
option. Selecting any of the other options might give you the kind of bullet or number
you want, but it will be local formatting, which you should avoid. Instead, use styles to
control the types of bullets and numbers, which we will cover later.
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How to Create Multiple Levels in the
Bulleted List

Creating the bulleted list was easy, but there are a couple of places where there should be
secondary lists within the main list. We will fix that now.

1. Select the second and third bullet items.

2. In the Home ribbon, click . (Alternatively, you can press the TAB key.)
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Those items are indented.

3. Select the next two bullet items under Life jacket.
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4. Once again, click or press the TAB key.

The list should now look like this.
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How to Create a Simple Numbered
List
1. Place your cursor at the end of the last bullet item and press ENTER twice to exit from the list

and create a new empty paragraph.
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2. Copy and paste the following text at that location.

How to Kayak

Find a good area.

Calm, shallow water

Say, "Hello, water. Mind if I kayak?"

Thank the water.

No rocks

Place the kayak in the water.

Put the front end in first.

With your hand on the back of the kayak, position it in the water.

Get in the kayak.

Paddle like the wind.
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3. Place your cursor anywhere in the first paragraph that you just copied ("How to Kayak"), and
from the Home ribbon, click in the Style drop-down and select h3.

When finished, it should look like this.
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4. Select the rest of the text under the new heading.

5. From the Home ribbon, click the down arrow on the List button and select Numbered
List.

You now have a simple numbered list under the bulleted list.
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How to Create Multiple Levels in the
Numbered List

Like the bulleted list, we need some additional levels in our numbered list.

1. Select list items 2-5.
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2. In the Home ribbon, click or press the TAB key.

Those items are indented.
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3. In the new sub-list, select items 2-3.
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4. Click or press TAB.

Now there are three levels.
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5. Select list items 3-4.
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6. Click or press TAB.

The list should now look like this.
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7. We don't want all of the sub-lists to use regular decimals like the first level. In fact, we want
one of those lists to use bullets. So right-click the ol structure bar to the left of the first sub-
list.
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8. Select List Type > Bullet List.

The list should now look like this.

9. Click to save your work.
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CHAPTER 4

Editing and Applying List Styles
We have a couple of multi-level lists. However, those lists aren't using the kinds of numbers and
bullets that we want at the various levels. So let's make some style changes.

This chapter discusses the following:

How to Control the List Style Type for First-Level Bullets 32

How to Control the List Style Type for Second-Level Bullets 38

How to Control the List Style Type for Second-Level Numbers 42

How to Control the Spacing Between List Items 44
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How to Control the List Style Type for
First-Level Bullets
1. From the Content Explorer, expand Resources > Stylesheets. Then double-click Styles.css.

2. Make sure the following are selected in the Stylesheet Editor.
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3. On the left side, scroll down and select ul. This style controls the first level of unordered (or
bulleted) lists.
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4. On the right side, expand the List group.
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5. Notice that the list-style-type property already has "disc" as its selection. A disc is a solid,
round bullet. We want to change this so that the first level of a bulleted list uses a square
instead. So to the right of this property, click .
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6. From the menu, scroll down and select square.

7. Click to save your work.
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8. Go back to the Attractions.htm topic. Notice that the bulleted lists now use squares. Even the
second-level lists are using squares, because they are inheriting the setting from the first
level.
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How to Control the List Style Type for
Second-Level Bullets
1. Go back to the stylesheet.

2. On the left side, scroll up and expand (Complex Selectors).
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3. Scroll down to the styles that begin with li p. These are complex (or advanced) selectors
related to lists that are already in the stylesheet. Some are displayed in gray because no
explicit settings have been placed on them yet. A complex selector is a style that combines
two or more selectors in some way. When you see a complex selector that separates the
individual selectors by a simple space (e.g., ol ol), that means you are telling Flare what to do
in case one selector is found inside another selector in a topic. In our case, we have some
nested bulleted lists with two levels (i.e., ul ul). We also have some nested lists within a
numbered (ol) list. You can even combine numbered and bulleted lists together, which we
have created in the previous lesson. So "ol ul ol" means a numbered list within a bulleted list,
which in turn is inside a numbered list.
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4. We could make changes to multiple combinations of lists, but we are only going to change a
couple of them. First, select the ul ul complex selector.

5. On the right side, notice that "square" is already selected as the list-style type, since it is
inheriting form the simple "ul" selector that we already changed. But we want our second-
level bullet items to use something different. So click , and from the menu select circle.

6. Click to save your work.
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7. Go back to the Attractions.htm topic. Notice that the second-level bulleted lists now use
circles, but the first-level bulleted lists still use squares.
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How to Control the List Style Type for
Second-Level Numbers
1. Go back to the stylesheet.

2. On the left side, select ol ol.

3. On the right side, notice that "decimal" (a regular number) is already selected as the list-style
type, since it is inheriting form the simple "ol" selector. That's what we want for the first-level
bullets, but not the second level. So click , and from the menu select lower-alpha.

4. Click to save your work.

CHAPTER 4  42



5. Go back to the Attractions.htm topic. Notice that the second-level numbered lists now use
lower-alpha characters, but the first-level bulleted lists still use decimals.

NOTE In this tutorial, our project stylesheet already had the complex selectors that we
needed. However, you can always create new complex selectors if you need something
else (e.g., a "ol ul ul ol" selector).
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How to Control the Spacing Between
List Items

Changing the list-style-type property isn't the only way you can modify the look of lists. You can
make all kinds of changes (fonts, borders, spacing, indentation, etc.), and not just to the main ol and
ul containers. You can also adjust the look of li selectors (or list items). Let's do that now to
increase the amount of space between items in a list. Therefore, we're going to change the bottom
and top margins. If we wanted to change the indentation, we could edit the left margin setting.

1. Go back to the stylesheet.

2. On the left side, scroll down and select li.
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3. On the right side, expand the Box group.
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4. Change the margin-bottom and margin-top values to 40px. Click outside of the second cell
after you enter the value. A margin of 40px is way more than what we really want, but we'll do
this temporarily so you can see the results.

5. Click to save your work.
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6. Go back to the Attractions.htm topic. Notice that the increased spacing.

7. Go back to the stylesheet and change the values to 16px. Click outside of the second cell
after you enter the value.

8. Click to save your work.

9. Go back to the topic and notice the change.
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10. There is another related style to change. In the stylesheet, scroll up to the (Complex
Selectors) group, and select li p. We need to make the same change to this complex selector
because it will account for list items where a paragraph tag occurs within it, which is what we
will be covering in the next lesson.
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11. Set the margin-bottom and margin-top values to 16px. Click outside of the second cell after
you enter the value.

12. Click to save your work.
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CHAPTER 5

Adding Content Between List
Items
We have some lists now, which we have styled. Sometimes you want to add extra information
between list items, such as a note or image. This requires a paragraph tag within a list item, like
this:

This structure is the default behavior when you create a new list, unless you have previously
changed this setting in the Options dialog (File > Options > XML Editor tab). Selecting Paragraph
automatically adds <p> tags within <li> tags, and Simple just uses <li> tags in lists.
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You can also manually change the setting for an entire list or for individual list items. Let's do that
now, and see how this affects the ability to add content between list items.

This chapter discusses the following:

How to Manually Add or Remove Paragraph Tags in Lists 52

How to Add Content Between List Items 56
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How to Manually Add or Remove
Paragraph Tags in Lists
1. Open the Attractions.htm topic where we have created the lists.

2. To the left of the numbered list, right-click the ol structure bar, and from the context menu
select Make Simple Item(s).
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All of the <p> tags are removed from the <li> tags.

3. Right-click the li tag next to step 3 ("Get in the kayak").

CHAPTER 5  53



4. From the context menu, select Make Paragraph Item(s) (or press CTRL+;).

A <p> tag is inserted within that <li> tag.

This means you could add content between steps 3 and 4, without disrupting the numbering.
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5. Right-click the outer ol structure bar again, and from the context menu select Make
Paragraph Item(s).

Now we are back where we started, with <p> tags inside all <li> tags.

6. Click to save your work.
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How to Add Content Between List
Items
1. At the end of step 3 ("Get in the kayak"), press ENTER. You should now see an empty step 4.
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2. With your cursor still on that line, press the BACKSPACE key.

The number is removed and you should see a yellow arrow to the left of the new
paragraph. That simply provides a quick way to exit the paragraph mode and go back to a list
item.
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3. Type the following in the new paragraph:

We recommend not falling out.
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4. Let's add one more line under step 3. Press ENTER at the end of the paragraph, press the
BACKSPACE key, and type the following:

Seriously, don't fall out.

Notice that the additional content did not disrupt the numbering of the list. You still have
steps 1-4.

5. Click to save your work.
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CHAPTER 6

Setting Page Breaks in Lists
For our PDF output, it is sometimes necessary to include page breaks in lists so that they continue
where you want from one page to the next. There are a couple of ways to add page breaks (via
styles or manually), and we will do both in this lesson.

This chapter discusses the following:

How to Add Page Breaks via Styles 61

How to Add Page Breaks Manually 73
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How to Add Page Breaks via Styles
1. Before we add a page break, let's build our PDF output so that we can see where we want it.

Select the Project ribbon. Then, from the Build Primary drop-down, select Build All-About-
Austin-PDF.

2. After it finishes building, double-click the row in the Builds window pane at the bottom to
open the PDF.
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3. Scroll down, and at the bottom of page 8, notice the beginning of the bulleted list.

4. We decide that it might look better if the heading and list started on the next page. So let's
place a page break on the heading through a style. Begin by closing the PDF, then in Flare
open the Styles.css stylesheet.
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5. On the left side of the editor, scroll down and select h3. Then, in the toolbar, click Add
Selector.

6. In the dialog, type Page-Break-Before as the name of the class, and click OK.

CHAPTER 6  63



7. On the right side, expand the PrintSupport group, and set the page-break-before property to
always.

8. Click to save your work.
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9. Open the Attractions.htm topic, and select (i.e., left-click) the h3 structure bar of the heading
"Things You Need for Kayaking." The entire heading should be highlighted.
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10. From the Home ribbon, click the Style drop-down and select h3.Page-Break-Before.

11. Click to save your work.

12. Rebuild the PDF target, and open it when it finishes.
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13. Scroll down in the PDF to pages 8-10, and notice the heading and list now begin on page 9.
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14. Also notice that step 2 of "How to Kayak" is now at the bottom of the page, and it has sub-
steps under it, which are now at the top of page 10.

15. Let's add a page break to step 2 in order to keep it on the same page as its sub-steps. First
close the PDF.
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16. Go back to the stylesheet and repeat steps 5-8, but instead of creating the class for h3, do it
for the li style. When you are finished, you should have a class called li.Page-Break-Before
with the page break associated with that class.

17. Click to save your work.
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18. Open the Attractions.htm topic, and select (i.e., left-click) the li structure bar for step 2. The
entire list item, including its sub-steps, should be highlighted.
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19. From the Home ribbon, click the Style drop-down and select li.Page-Break-Before.

20. Click to save your work.

21. Rebuild the PDF target, and open it when it finishes.
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22. Scroll down in the PDF to pages 9-10, and notice that step 2 now begins at the top of page 10.

23. Close the PDF.
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How to Add Page Breaks Manually
Styles are almost always recommended over doing something manually. However, you might want
to use the manual page break sometimes. For example, you might have a list that appears in
multiple outputs, and in some outputs you want a page break to appear in a certain place, but in
other outputs you might not want a page break. You could have two instances of a list item (one
with a page break style applied and one without), then condition each list item for the different
outputs. However, it might be simpler to just insert a manual page break and condition that for only
the targets where the page break should occur. Keep in mind that with manual page breaks, the
break always occurs after its insertion point.

1. Go back to the Attractions.htm topic and undo the application of the li.Page-Break-Before
style class to step 2. In other words, you want step 2 to only use the parent li style.
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2. Place your cursor somewhere on the last line ("No rocks") under step 1. Then, press the down
arrow key on your keyboard four times, until you see a horizontal line flashing between the
steps.
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3. Press ENTER. You should now see an empty step 2. However, this number will go away when
we are finished.
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4. The empty list item has a <p> tag in it, like the others. We need to remove this tag before
inserting the page break. So right-click the li structure bar and select Make Simple Item(s).
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5. Place your cursor in the empty step 2. Then from the Insert ribbon, select Page Break. A gray
bar appears at that location and the number is removed next to it.

You don't need to condition the bar unless you want it to be used in only some print-based
outputs but not others. It will automatically be ignored in online outputs.
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6. Click to save your work.

7. Rebuild the PDF target, and open it when it finishes.

8. Scroll down in the PDF to pages 9-10, and notice that step 2 begins on page 10.

9. Close the PDF.
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CHAPTER 7

Creating Advanced Lists With
Autonumbers
In addition to using the quick list drop-down menu, you can use autonumbering to create more
advanced types of lists. You might want to use autonumbering on lists, for example, if you want the
list items to contain text in addition to numbers (e.g., Step 1, Step 2, Step 3). A list using
autonumbers also supports cross-references to specific list items.

This chapter discusses the following:

How to Add Autonumber List Styles 80

How to Apply Autonumber List Styles 83

How to Insert a Cross-Reference to a Step 88
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How to Add Autonumber List Styles
There are many ways to accomplish most things with styles. The following styles and settings are
just one way to do it for a simple, single-level list. If you want to create multiple levels or add
comments between steps, more styling is necessary.

Also, with the following we are associating autonumbers with an ol style class, but you can
accomplish something similar by using autonumbers with paragraph style classes.

1. Copy the following.

ol.StepNumber > li
{
    list-style-type: none;
    mc-auto-number-format: 'S:Step {n+}: ';
    mc-auto-number-class: StepNumber;
    margin-left: -35px;
    padding-left: 59px;
    text-indent: -59px;
}

ol.StepNumber > li:first-child
{
    mc-auto-number-format: 'S:Step {n=1}: ';

}

span.StepNumber
{
    font-weight: bold;
}

MadCap|xref.StepNumber
{
    mc-format: '{paranumonly}';
}

2. From the Content Explorer, expand Resources > Stylesheets.
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3. Right-click Styles.css, and from the context menu select Open with > Internal Text Editor.
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4. Scroll to the bottom of the editor and paste the styles.

5. Click to save your work.
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How to Apply Autonumber List Styles
1. Open the Attractions.htm topic.

2. Scroll down to the bottom of the topic, click at the end of the final list item, and press ENTER
twice to create a new empty paragraph after the list.

3. Copy and paste the following at that location.

How to Get to Lady Bird Lake

Get in the car.

Follow the GPS directions to Lady Bird Lake.

If your mom calls, pull over safely and stop the car to take the call.

Go back to .
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4. Place your cursor anywhere in the first paragraph ("How to Get to Lady Bird Lake"), and from
the Home ribbon, click in the Style drop-down and select h3.
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5. Select the rest of the text under the new heading.

6. From the Home ribbon, click the down arrow next to the List button and select
Numbered List.

You now have a simple numbered list.
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7. Before continuing, we need to remove the <p> tags from the <li> tags. So right-click the ol
structure bar for the list, and from the context menu select Make Simple Item(s).

8. Select (i.e., left-click) the ol structure bar for the list.

The entire list should be highlighted.

9. From the Home ribbon, click the Style drop-down and select ol.StepNumber.
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10. Initially the numbering might not be seen in the XML Editor, so press F5 to refresh.

The list should now look like this.

11. Click to save your work.
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How to Insert a Cross-Reference to a
Step
1. Click before the word Follow in step 2. Then, from the Insert ribbon, select Bookmark.
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2. Type GPS as the name of the new bookmark and click Add.

A marker is shown in step 2 (if you have markers turned on). Markers do not display in the
output.
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3. In step 4, click right before the period at the end of the sentence, then in the toolbar click .
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4. In the dialog select Place in this document. Under Bookmarks, select GPS. And at the bottom
of the dialog, select MadCap:xref.StepNumber.
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5. Click OK.

The autonumber for step 2 is automatically used as the link.

6. At the end of step 1 press ENTER to create a new list item, and type Buckle your
seatbelt.

7. Press F5 to refresh the editor.

It should look like this now. Notice that the link still says "Step 2," even though the GPS
information is now on step 3.

CHAPTER 7  92



8. From the Tools ribbon select Update Cross-References.

9. In the dialog, click Update. Notice the link now shows "Step 3."

NOTE It's not mandatory that you refresh the XML Editor or update the cross-
references. Doing that is only for you to make sure the content is correct. If you fail to
do this, the output will still be correct.

10. Click to save your work.
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CHAPTER 8

Creating a Definition List
A definition list is used to create a group of terms and definitions. It is also sometimes referred to
as a description list, and although it is called a "list," it does not have bullets or numbers. Instead, it
is similar to a table that doesn't have borders (although it can have borders, shading, etc. if you edit
the necessary styles).

One of the benefits of creating a definition list instead of using a table has to do with snippets.
While creating snippets for parts of a table can be quite difficult, if not impossible, producing
snippets from parts of a definition list is easy.

Let's create a definition list and also create a snippet from part of it.

This chapter discusses the following:

How to Create a Definition List 95

How to Create a Snippet in a Definition List 100
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How to Create a Definition List
1. Open the Austin-City-Limits.htm topic.

2. Click at the end of the final paragraph, and press ENTER to create a new empty paragraph.
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3. Type Hall of Fame, apply the h2 style to it, and press ENTER.

4. Type Stevie Ray Vaughn.
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5. From the Home ribbon, click the down arrow on the List button and select Definition List.
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The text is indented and placed in a <dt> tag, which in turn is placed inside a <dl> tag. The
<dl> tag is for the entire definition list. The <dt> tag is for the definition term.

6. Press ENTER, and on the next line type Inducted in 2014.

Notice that text is placed within a <dd> tag, which is for the definition of the term above it.
The text is also indented even more because of the left margin currently associated with that
style.

7. Press ENTER. Another <dd> tag is added, in case you want to add a second line for the
definition.
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But let's move on to another term. So press ENTER one more time. Now the empty line is
inside a <dt> tag.

8. Type Willie Nelson and press ENTER.

9. Type Inducted in 2014 and press ENTER twice.

10. Type B.B. King and press ENTER.

11. Type Inducted in 2016.

The list should now look like this:

12. Click to save your work.
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How to Create a Snippet in a Definition
List
1. Select the two lines for Willie Nelson.

2. From the Home ribbon select Create Snippet.

3. In the Snippet File field, type Willie-Nelson, replacing the text in that field.

4. Click Create.
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The content is now contained in a snippet tag.

However, if you were to open that snippet, you would see that the two lines are still placed
within <dt> and <dd> tags. Therefore, you can insert that snippet within any definition list and
it will function just like the other terms and definitions in the list.

5. Click to save your work.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Tutorials
Getting Started Tutorial

Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Central Integration
Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide

APPENDIX  104


	CHAPTER 1
	Welcome

	CHAPTER 2
	Creating a Project From a Template
	How to Create a New Project From a Template


	CHAPTER 3
	Creating Bulleted and Numbered Lists
	How to Create a Simple Bulleted List
	How to Create Multiple Levels in the Bulleted List
	How to Create a Simple Numbered List
	How to Create Multiple Levels in the Numbered List


	CHAPTER 4
	Editing and Applying List Styles
	How to Control the List Style Type for First-Level Bullets
	How to Control the List Style Type for Second-Level Bullets
	How to Control the List Style Type for Second-Level Numbers
	How to Control the Spacing Between List Items


	CHAPTER 5
	Adding Content Between List Items
	How to Manually Add or Remove Paragraph Tags in Lists
	How to Add Content Between List Items


	CHAPTER 6
	Setting Page Breaks in Lists
	How to Add Page Breaks via Styles
	How to Add Page Breaks Manually


	CHAPTER 7
	Creating Advanced Lists With Autonumbers
	How to Add Autonumber List Styles
	How to Apply Autonumber List Styles
	How to Insert a Cross-Reference to a Step


	CHAPTER 8
	Creating a Definition List
	How to Create a Definition List
	How to Create a Snippet in a Definition List


	APPENDIX
	PDFs
	Tutorials
	Cheat Sheets
	User Guides



